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Toolbar Reference Manual

This reference manual complements eLeanor with functional descriptions of all 

the buttons in the eVSM toolbar (ribbon) and some other core functionality.
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New users of eVSM should begin with eLeanor, the eVSM learning and certification site at 

https://evsm.com/learn. eLeanor is a points based fun learning environment which uses multi -

media and facilitates anytime, anywhere, individual, or team based training. The eVSM Group 

also offers live instructor-led training, see details at https://evsm.com/services.

This reference manual complements eLeanor with functional descriptions of all the buttons in the 

eVSM toolbar and some other core functionality.

The manual is designed both for on-screen viewing and print. For on-screen usage, the manual is 

best viewed in Acrobat Reader. To search, use the Ctrl+F shortcut. Also, it is a good idea to set 

the Acrobat view to "Show two pages side-by-side".

For hardcopy, print the manual on double-sided paper and use the table of contents or the index 

to quickly find answers to your questions.

Use Ctrl+F to 

Search in Acrobat 

Reader



Copyright © 2019 The eVSM Group, All Rights Reserved 1



Copyright © 2019 The eVSM Group, All Rights Reserved 

Value stream mapping provides a high level view of a lean deployment. Its methodology is well 

laid out in the series of workbooks from the Lean Enterprise Institute (www.lean.org). The eVSM 

software has been designed to complement these workbooks and provide lean practitioners a tool 

to support their value stream mapping activities, starting from paper and pencil through 

improvement projects, leading to a leaner future state.

The primary modules in eVSM (Sketch, Sequence, Validate, Calculate, Visualize, Improve) are 

deliberately organized to match the process steps that we have seen practitioners follow in their 

mapping activities.

We have seen eVSM used in three ways in our user community:

1. By practitioners who simply want to capture a map electronically and want access to a 

complete VSM icon set that is easy to use.

2. By practitioners that want to draw a map and do simple calculations in Excel corresponding 

to data on the map.

3. By practitioners who want highly standardized and automated maps to include icons as well 

as variables, lean equations, charts, and improvement methodology. 

While the third approach best leverages the software in a lean deployment, its drawback in the 

past has been the learning curve associated with its usage. eVSM has introduced ready -built 

stencils for different application areas to address this issue. Applications include:

▪ Plant level mapping for discrete parts and assemblies

▪ Plant level mapping for food and chemical processes

▪ Supply network mapping

▪ Services and information flow mapping

▪ Facility layout design

There are also a collection of other stencils available such as Kanban calculations, spaghetti 

diagramming, milk run design, etc.
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Note that the main eVSM stencil (typically named eVSM vX.XX) is on the left of the screen. We 

refer to this as the “Main Stencil”. It’s important that this stencil is never closed. The main 

stencil is organized into sub-stencils, so that it is easier to find shapes, and are also found on the 

right.

Any Quick eVSM stencils (such as Quick Mfg) are docked on the left of the screen. We refer to 

such stencils as the “Quick Stencil”. Click and drag the Quick Stencil header bar to move it to 

this docked position.

See current system requirements for eVSM at 

https://evsm.com/installhttps://evsm.com/install

The best way to start a blank value stream map is to double-click the eVSM icon on your 

desktop. If your Visio security setting is set to anything but low, messages will come up asking 

for permission to “Enable Macros”. You must answer “Yes” allow macros to run. 

Start eVSM

Quick Stencils

eVSM shapes 

stencils

eVSM Main 

stencil

eVSM 

toolbar

https://evsm.com/evsm-technical-support#toc-1https://evsm.com/evsm-technical-support#toc-1

For later updates to eVSM see: 

http://www.evsm.com/install
http://www.evsm.com/install
https://evsm.com/evsm-technical-support#toc-1
https://evsm.com/evsm-technical-support#toc-1
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eVSM has a collection of value stream mapping shapes that appear in the main 

eVSM stencils to the right of the drawing page.

These shapes, behaviors, and corresponding functions have been designed from 

the outset to support the series of lean workbooks from the Lean Enterprise 

Institute (www.lean.org) and its worldwide network partners. The primary 

workbook impacting the design has been “Learning To See”.

As software usage has become widespread across multiple industries, the icon 

language has been extended to keep pace with practitioner requests and lean 

publications in each industry. 

In addition to the basic icons to the right of the drawing page, eVSM includes Quick stencils for 

Manufacturing, Enterprise, Processing, Transactional, Warehousing, and Healthcare. 

These quick stencils offer rapid map development complete with automated analysis and 

charting. 

The Help button on the toolbar requires an internet connection and will open up a web browser 

pointed to the eVSM help site at www.evsm.com/learn.

We offer technical support for the latest release of the eVSM software through our Maintenance, 

Enhancement, and Support program.. Please email us at support@evsm.com.

eVSM v11eVSM v11

HelpHelp
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To resize the page, hold down the CTRL key and move the cursor to the middle of the edge of 

the page. The cursor will turn into a double-headed arrow. Simply grab the edge and pull it to the 

required size.

Shapes are designed to be grid-sized. The drawing page has a grid on it. Snap shapes to grid 

locations for easy alignment.

Avoid resizing shapes. Shapes are designed to fit together and resizing a shape will make “fitting” 

shapes together difficult and create a lot of extra work.

Drag and drop eVSM icons from the stencil onto the drawing page.

Blue icons represent stacks of shapes. Access the stack by dragging out the shape 

and then clicking the right mouse button.

Cross Dock

In_Store Storage

Moment_Of_Truth

Picture Process

Process

Process Cell

Production Control

Rework Process

Shared Process

Warehouse

Straight Arrows

Icons with a blue square in the top right corner symbolize that shapes in that icon stack are used 

for visual purposes only, and not used for calculations. 

Process
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Twice per 
week

The Visio Text Block Tool (located in the Visio Home toolbar) can be used to resize 

or move the text within a shape.

When active, the Text Block Tool displays control handles around the text belonging 

to a shape. These control handles can be used to position and size the text block.

Caution: Be sure to de-select the Text Block Tool when finished. You can deselect it by clicking 

it again in the toolbar, or by clicking the Pointer tool also in the Home toolbar.

Double-click a shape to edit its text. Some eVSM shapes require additional steps to change text. 

Just double-click and then follow the on-screen instructions.

The eVSM stencils (*.vss files) are stored in the "C:\Program 

Files (x86)\eVSM\Setup\Solutions" folder. You can open these in 

Visio by clicking "More Shapes > Open Stencil..." at the top of the 

shapes pane on the left.

If the stencils on the right side of your eVSM session are missing 

then you need to open all the stencils with the name starting with 

"eVSM_". These will open on the left, so you need to drag them 

over to the right.

Text Block ToolText Block Tool

Twice per 
week
Twice per 
week

Twice per weekTwice per week

Pointer Tool
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Pages can be created, deleted, etc. via the right mouse menu on the page tabs.

Rules for Visio drawing page naming:

• Page names must start with an alpha character.

• Page names must be limited to 0-9 and A-Z characters. Characters such as [!@#$%^&*()|+-
?] are not allowed.

• Page names should be kept as short as possible.

Insert Page…

Delete Page

Rename Page

Reorder Pages...

▪ CTRL-SHIFT-Drag Select region (Zoom into the selected region).

▪ Try the Visio menu “View > Task Panes > Pan & Zoom” for another navigation option with 

a mini-window.

▪ To set up the mouse scroll wheel to zoom, use the Visio menus: “File > Options > 

Advanced” and check:

▪ Visio 2013 (and later versions) has zoom controls at the bottom right of the window.

Visio shapes can simply be selected, copied and then pasted into other Microsoft office 

applications like PowerPoint and Excel. Be sure to paste a picture using the “Paste As…” 

command. This will allow re-sizing of the pasted picture without requiring editing and font 

adjustments.

Acrobat PDF allows capture of any size drawing in a single file, which can be viewed with the 

free Acrobat Reader, and is easily printable. On-screen viewing is good, it is searchable, and 

supports password security. Visio 2019 allows direct creation of PDF files. 

Zoom on roll with InteliMouse

Center selection on zoom

Zoom on roll with InteliMouse

Center selection on zoom
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Visio allows drawings of any size. The drawings can then be printed on any size paper supported 

and available on the printer.

When the drawing size does not match the paper size, you can either print across several sheets, 

or shrink (or expand) the drawing to fit the paper by clicking “File>Page Setup…” and then 

checking the “Fit to 1 sheet” radio button.

The “File>Print Preview” function can and should be used to assess the print output before 

committing the drawing to paper.

Common bitmap formats such as JPEG, GIF, and TIFF can be viewed in most browsers and 

mobile devices without any additional software. eVSM maps can be converted to these and other 

graphic formats from the “File>Save As…” menu. In the “Save As” dialog, click the “Save as 

type” pull-down and select the format.



Copyright © 2019 The eVSM Group, All Rights Reserved 

The eVSM Software essentially generates a Visio file. The printing of the file is handled by 

standard Visio functionality. Problems printing from Visio could be due to Visio, the print driver, 

or the printer.

Here are some suggestions if you have problems printing from Visio:

▪ Make sure you have the latest Visio Service Patch installed

▪ Try copy/pasting your VSM to PowerPoint or Excel and then print from there

▪ Convert your VSM to Acrobat PDF and then print the PDF file

DON’T  resize eVSM Shapes whenever possible.

DO Snap shapes to grid locations.

DON’T  close eVSM Stencils.

DO zoom in fast with CTRL-SHIFT-Drag.

DO zoom out quickly with CTRL-SHIFT-W

DO use a mouse to be productive with eVSM.
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Lists the sketcher stencils available and allows one to be selected. The 

corresponding Quick Stencil will also be activated. Note that only one 

sketcher stencil can be used per map.

OpenOpen

NUMNUM Opens the Name Unit manager which manages the names, units and 

equations used on this map. If used in conjunction with a Quick 

Stencil, its important NOT to modify variable and unit names or 

equations. Typically a few unit names might be added.

View a window showing all data for the selected center.

This section is focused on the first electronic capture of a map and data input. This area is ONLY 

for those using Quick stencils. 

List Variables

Wall Map Import a photo of an existing value stream map, and scale for drawing 

the map in eVSM.

Creates an input data sheet in the same folder as the Visio file and 

opens it up on the PC. You can now add data into the cells and then 

use the ‘Import XL’ button to bring the data onto the map.

Imports the data from the worksheet that was created by the ‘Create 

XL’ button. 

Scale locations of shapes on the page to stretch or shrink the map. 

Reverse the last stretch scale you applied.Reverse Scale

Scale Locs

Import XL

Create XL
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The Sketch Module allows you to quickly capture a wall map in eVSM. It can also be used to 

simply capture the flow of the value stream with no data. Built in commands allow you to add the 

data later when needed. The main steps in the Sketch Module are:

1. Use the Wall Map button to import your wall map picture(s) into eVSM, and scale the image.

2. Use the Open button to select the application area (manufacturing, services, etc.) for your 

map.

3. Use the Sketch stencil to capture the flow over the wall map image. 

4. Once the initial capture has been done, add data to the map and enter the data. 

The Wall Map function provides an efficient way to convert an image of the wall into an 

electronic VSM. If your wall map is simple enough to capture in a single clear photo (must be 

able to read all text), then import the image into eVSM with the steps below. If the map is 

complex and requires multiple images then see section 1b on the next page. 

1. Click the Wall Map button in the toolbar.

2. Click the Insert Wall Map button to browse for 

your wall map picture on your computer.

Wall Map

3. Select the picture and click Open.
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4. To scale the picture, draw a rectangle 

over any one process box. Click the 

Done button when finished.

5. Next a form will appear allowing you to change the 

transparency of the picture, make it visible/invisible 

on the page, or delete the picture. After you click OK, 

if you need to get back to this form, click the Wall 

Map button in the toolbar again.

6. The image will become the background of the Visio 

drawing page, allowing you to drop shapes on top 

without it moving. To delete the image, click the 

Wall Map button in the toolbar. 

Wall Map

Wall Map
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For more complex maps requiring multiple images, here are some tips for good results:

a.) Take all photos from approximately similar distance from the wall. This will ensure 

similar scale.

b.) Capture sufficient overlap between pictures so nothing is missed.

c.) Ensure lighting is similar for all photos.

d.) Hold camera square to the wall to minimize skewing of the image.

2. Line up the pictures so that the wall map is aligned 

properly. 

1. Use the Insert>Picture option in Visio to import all of the pictures on your Visio page.

3. Hold down the SHIFT key and select each picture. 

Right-click on the selected images and choose 

“Copy”.  

4. Delete the images from the Visio page.   

5. Right-click on the page and select “Paste Special”. 

Choose the “Picture (Enhanced Metafile)” option and 

click OK.

6. All of the images should now be joined into 

one single image now. Crop or resize the 

image to fit the desired drawing page size. 

8. Click the Wall Map button in the toolbar, and follow the steps on the previous page of 1a. 

7. Click File>Save As. Name the image and then in the “Save as Type” dropdown, select 

“Graphics Interchange Format (*.gif)”. Click Save.
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eVSM 
Data

QuickMfg
11.06.002

8.0

1. To start drawing on your map, click on the Open button in the toolbar to open up the 

Sketcher stencil. From the pop-up menu, select which kind of map you’re drawing, for 

example, Quick Manufacturing. 

Open Open 

The shapes shown above are those used in the example map.

As with all eVSM drawings, start your map by dragging out the red shapes (Customer Sketch and 

Time Sketch) first.

2. Once you select what type of map you’re drawing, the corresponding Quick Stencil will be 

placed in the forefront of the other Quick Stencils. Also, the Sketcher stencil will open with 

all of the shapes associated with that type of map.

Process
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Process
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If you’re using a picture of a hand-drawn map as a guide, start dragging out the different Sketch 

shapes on top of each process as shown below. Otherwise, just recreate your basic process using 

the different Sketch shapes.

An alternative method can be done once a red shape has been 

placed on the drawing page. You can use the right mouse button 

menu (shown to the right) and select the various Sketcher shapes 

to drop them at the location clicked on the page.

Note: If you need additional map space, 

hold down CTRL and click and drag the edge of the page.

 

Process

Type

Process

Type

Customer

Type

Process Process

Type

1414

Day

Hr

Day

Hr

55

Wk

Day
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Day
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eVSM 
Data

QuickMfg
11.06.002

8.0

Now you can either add data to an individual shape or to the whole map. If you right -click on 

any shape, you will see 4 options regarding the adding and removing of data:

• Add all data (shape): adds input and calculated data to the specific shape that you have 

selected 

• Add all data (page): adds input and calculated data to all shapes on that particular page

• Remove all data (shape): eliminates the input and calculated data from the specific shape that 

you have selected 

• Remove all data (page): eliminates the input and calculated data from all shapes on that 

particular page

For this example, right-click on any shape and select “Add all data (page).
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Annotate the map and fill in the values according to your wall map. Now you can finish the map 

by adding arrows from the eVSM Arrows stencil and add-on variables from the Quick stencil.
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If you want to create a custom unit that you would like to use throughout the map, start with the 

Name and Unit Manager. If you want to use a built -in unit but need to convert it, such as Weeks 

to Days, start with Step 3.

1. Click the Name and Unit Manager button in the eVSM toolbar. NUMNUM

2. Click on the “New Unit” 

button in the form and 

create a new unit named 

“Part”.
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3. Drag out a Units Converter shape from the eVSM Data stencil or the main stencil on the right 

of the screen. 

4. Double click on the default unit “Hr” to change the top unit 

to “Part” and the default unit “Min” to change the bottom 

unit to “Item.” This allows the calculator to account for the 

new unit. The top unit is the original unit, while the number 

specifies how many of the bottom unit makes up one of the 

top unit.
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Min

6060
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Min
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22
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5. If you have more than one custom unit, repeat step two and three.

6. Double-click on the unit.

Note: Only the custom units that you created via a unit converter(s) will appear in the form when 

trying to change a variable unit on a center. This is to avoid (for example) people converting 

quantity units to time units for a center, like the Inventory Center. To ensure that the units you 

want to change appear in the form, create the converters first between any units you plan to use. 

7. This form appears showing 

that it is “legal” to 

convert “Item” to “Box” 

or “Part” because unit 

converters exist between 

these three.

8. Selection of “Box” in the 

form causes the unit to be 

replaced in the data box.

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0010 #0A0020

Type Type

Inventory ItemxxInventory Itemxx Inventory BoxxxInventory Boxxx

22

Part

Item
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6060
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Part
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Miscellaneous Tips

eVSM comes with built-in basic unit conversions that don’t require a Units Converter. To check 

and see which unit conversions are included, open the NUM and click “Unit Converters.”

If the conversion you need isn’t listed, you will need to 

include a Units Converter on your map in order to use 

your units. If the conversion you need is listed then you 

will not need to include a Units Converter. An error 

may appear if you add an additional Units Converter for 

a conversion that is included in eVSM, such as hours to 

minutes.
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The Name & Unit Manager (NUM) provides a simple way of managing the names and units on a 

map via this toolbar button.

The purpose of this management environment is to:

1. Provide a means to type in a name only once and then use it consistently through out the 

map.

2. Provide a means to associate a default unit with a name so that when a name is selected, the 

unit is automatically set.

3. Provide a means of creating a starter set of names and units for different application areas 

such as manufacturing, healthcare, etc. This will allow a company to create standard 

variable sets and deploy them easily.

NUMNUM

The NUM function does not allow editing of names and units directly in the data shapes. New 

names must first be added to the NUM form. Then they can be accessed via right mouse button 

menus on the following data shapes.

Long NVU Short NVU Value Added Non Value Added Units 

Converter

The NUM form is divided into three parts: Sets, Units, and Names. Names and units visible in 

this dialog box represent the Current Set. Only the Current Set names and units are available on 

the right mouse button menu of datasets.

Unit Converter 

Visibility

Name Unitx.xxName Unitx.xx Name Unitx.xxName Unitx.xx Minx.xx Minx.xx Dayx.xx Dayx.xx

6060

Hr

Min

Hr

Min

Saved Sets
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Double-click on “Item/Day,” which will bring up a Unit Selection option. 

The Numerator can be changed to a different name, such as “Screw” rather 

than “Item,” and the Denominator can be adjusted to a different demand, 

such as items per hour. 

If you need to add a new unit, click on “Manage Names and Units…” 

which launches the Name and Unit Manager. 

Fractional units make computing demand or production much easier. 

For the Customer Center, the default unit is items per day. If demand 

is calculated on a different basis though, it is simple to change the 

units. 

This shows the original Customer Center 

converted to screws per hour.

When adding a custom unit as a numerator or denominator, it needs to be linked to its units 

family using a Units Converter shape.  For example, if you're trying to change a unit into "$/

Screw," instead of "$/Item," create a Units Converter showing how many Screws are equal to one 

Item. 

If you need to add a different unit of time, such as year, drag out another “Units Converter” 

shape from the eVSM stencil, add a new unit using the Name and Unit Manager, and specify the 

conversion rate. Make sure you add a Units Converter shape before trying to use a customer unit 

as a numerator or denominator in fractional units. It is easiest to keep track of any time 

conversions by placing them next to the Time Center.

In this example, “Week” was added as a new unit 

and the conversion to days was made using the 

Units Converter. Next, the Customer Demand was 

changed to items per week. The new unit “Week” 

can be used in any place requiring a unit. 

Customer

Customer

Customer 
Demand

Item
Day

x.xx
Customer 
Demand

Item
Day

x.xx

Customer 
Demand

Screw
Hrx.xx

Customer 
Demand

Screw
Hrx.xx

Customer

Customer 
Demand

Item
Week

500
Customer 
Demand

Item
Week

500
55

Week

Day

Week

Day

88

Day

Hr

Day

Hr

6060
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Min

Hr

Min
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Min

Sec
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To see a list of all of the data on a selected center, using the “List Variables” button will bring up 

a form of all of the hidden and visible data.

1. Select the green part of any center on your map. 

List Variables

The “List Variables” form can be left open as you click on different centers on the map. The 

form will update.

2. Click the List Variables button in the toolbar to bring up this form.

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0080

Milling Station

Qty Per Cycle Item2Qty Per Cycle Item2

Capacity
Item
Day

AutoCapacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto
Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %AutoOEE Percent %Auto

SecAuto SecAuto

11

Cycle Time Sec10Cycle Time Sec10

Blue indicates 

calculated 

values

Black for input values. These 

can be edited here, just 

double-click.

[ ] for distribution 

data. Only in 

eVSM Mix

This switch allows you 

to shorten the list. 

What goes in the short 

list is controlled in the 

Views dialog.
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Since the List Variables form can get very long, you can customize what variables are shown in 

the list through the “Variable Visibility” form. Click the “Views” button in the toolbar.

The “Show in List Vars” 

column allows you to select 

which variables will appear 

in the List Variables form.

ViewsViews
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1. To move the timeline and get it aligned, you can simply click on the VA or NVA shapes and 

manually move them. 

2. Alternatively, if you want to shift the entire timeline up or down you can right -click on any of 

the timeline shapes and choose “Select Timeline.” If that option doesn’t appear in the menu, 

make sure you have the entire VA or NVA shape selected and try again.

3. With the entire timeline selected, you can then move it to where you ’d like it. 

4. Similarly, in the right mouse menu there is an “Align Timeline” function that will create the 

ladder timeline for you if the VA and NVA shapes are not correctly aligned, as shown below.

   Disable Flying Connector

   Select Timeline

   Align Timeline

eVSM is designed as a grid system and each shape should fit neatly into the lines. If the shapes 

aren’t aligned to the grid, it could lead to later issues and so lining everything up should become 

a habit. It is best to line up the bottoms of each green center and then adjust the timeline, as 

shown below. 

eVSM 
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Activity Center
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Aliases are a feature in eVSM that allow a user to convert the variables into another language. 

They can also be used for companies that have a common language that is different than eVSM, 

such as referring to “Stations” as “Worktables.” Using Aliases allows a map’s names and 

variables to be easily updated to fit your needs. 

To start, first create an Excel file with two columns. In the first column, make a list of all the 

variables you would like to create an alias for. In the second column, list whatever you would 

like to variable to be changed to, like using the term “Employees” instead of “Associates,” or 

translating the eVSM term to another language.

In this example, the English eVSM terms are converted to German. Make sure that you label each 

column since the Alias converter starts on the second row in the Excel file. 

Also, label each page in your Excel file to whatever alias you ’re using, such as Spanish or the 

company language.  
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The conversions can be done on the entire list of variables and units or just on a select few. In the 

example below, the company only wants to use aliases for a few of the variable names so that 

their maps closer resemble terms used in the company.

Once your alias Excel file is complete, draw your map in eVSM or open an existing map. Open 

up the NUM by clicking the button in the eVSM toolbar.   

Click on the “Import 

Alias Names” button 

in the NUM.

NUMNUM
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Locate the file on your computer and open 

it. A dialog box will appear asking which 

worksheet you would like to use. This 

example will start with the German 

worksheet. 

Once you hit “OK,” the variables and units 

in the map will be changed to whatever was 

listed as the Alias. The map below shows 

the updated terms.

If you would like to switch back to the default eVSM names, open up the NUM and turn the 

Alias Mode off.
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To use a different set of aliases, copy the map to a new page (except for the NUM) and drag out a 

new NUM. Import the same data file as before but use the Company Language worksheet instead. 

Now, the map shows terms that are used by the company.
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PA0090

Activity Lead 
Time

Day0
Activity Lead 

Time
Day0

PA0100

Qty Per Cycle Item1Qty Per Cycle Item1

Capacity
Item
Day

AutoCapacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto
Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %AutoOEE Percent %Auto

Process

11

Cycle Time Secx.xxCycle Time Secx.xx

Type

PA0110

Inventory ItemxxInventory Itemxx

PA0120

Qty Per Cycle Item1Qty Per Cycle Item1

Capacity
Item
Day

AutoCapacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day
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eVSM 
Data

QuickMfg
11.06.002

8.0

If you want to add in a new variable with an Alias, click on the “New Name” button in the NUM.

Fill in the Name and then the Name Alias. 

Note that the Name will be used when the 

Alias Mode is off and the Name Alias will 

be used when the Alias Mode is on. 

Now that the name is added to the NUM, it 

can be added to the map and it will change 

when the Alias Mode is on or off.



Copyright © 2019 The eVSM Group, All Rights Reserved 

It is sometimes easier to capture the value stream flow before any data is collected. This can help 

clarify what data is necessary. The data can be typed directly into datashapes on the map. 

Alternatively, the data can be collected in an Excel datasheet. Input is easier in Excel, and it also 

allows you to collect data directly in the Gemba on a mobile device (anything that Excel can run 

on). It also allows you to more easily have other people collect the data. The Create XL and 

Import XL functions allow you to create a datasheet for your map and then import the data into 

the map.
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Visio Excel

Creates an input data sheet in the same folder as the Visio file and opens it up on the PC. The 

new datasheet will be given the Visio page name along with “_INPUT”. If a previous datasheet 

already exists, it will be renamed to “_INPUT_bk” so any prior data entered is not lost.

You can then add data into the cells and then use the ‘Import XL’ button to bring the data onto 

the map. 

Imports the data from the worksheet that was created by the ‘Create XL’ button. The format of 

the Excel datasheet must not be altered. Also, the location, filename, and the worksheet name 

must not be changed.

Import XL

Create XL
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The Import XL button also allows you to draw centers (Activity center, Inventory, Transport, 

Supplier, etc.) automatically on the map. See instructions below.

New centers are added 

below the blue row

Select center type from 

pulldown list in this 

column

Enter 

center 

name

The data values are 

entered in the white 

cells

The data values must 

be in the units shown 

here

The new centers appear 

below the drawing page. 

These can now be moved to 

the required location
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Reverse Scale

Scale Locs

While working on a map, you may need to keep many input and calculated values visible on the 

map. Your map could start looking like the one on the left below. The Scale Locs function 

explodes the view to look like the one on the right. The Reverse Scale function reverses the last 

scale expand.

Scale Locs
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Draw Sets

Show Set Colors

Isolate Set

Allows definitions of sets and the products within them. 

Draw needed Product Set Centers for any sets in the product data.

Shows set colors on the map.

Highlight activities for a selected Set Center. 

Mix Manager

The Mix Manager dialog box is where the products and sets are declared for the Value Stream. 

The Mix Manager allows you to add new products/sets and edit/delete exiting items. It also 

includes functions to create products and sets via Excel. 

eVSM Mix is a separate product, and needs to be licensed/activated separately. The Mix icons in 

the toolbar and the Mix Stencils are only available if a valid license is active for eVSM Mix. 

Mix Manager

Add Set

Remove Set

Allow the selected set to the selected sequence arrows and centers.

Disallow the selected set to the selected sequence arrows and centers.
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Once the matrix has been used to identify the common routes the data can be 

imported into eVSM by clicking the “Mix Manager” button in the toolbar and then 

the “Import” button on the dialog

The import brings the products and routing sets into the dialog and also draws the activities at the 

bottom of the page. They can be moved into their map positions from there 

You can add new products or edit their routings directly in the dialog.
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The Draw Sets button draws any sets which are defined in the Mix manager 

dialog which do not exist on the drawing page. The Product Set centers (along 

with the product key) are drawn on the right side of the drawing page and can be 

moved to any desired location.
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Select a Set Center and click the ‘Isolate Set’ button. This will fade away any paths or centers 

that are not on that set’s production path. Set B was isolated in the example below. 

Isolate Set

Route sets in eVSM are used to group all products which go through exactly the 

same route. Routes are specified with sequence arrows. Where multiple sets 

share a sequence arrow, you can specify which sets can pass through with the 

“Sets Allowed” variable built into the sequence arrows. This variable can be made 

visible via the Views dialog box, or can be accessed through the List Variables 

button. 

The Sets Allowed variable can be edited directly on each sequence arrow, 

however, for complex maps this can be very tedious. The Add/Remove Set 

functions make this easy. To use, just select a Set Center, select sequence 

arrows (holding down the shift key) you wish to change, and then click the “Add 

Set” or “Remove Set” buttons. You can check the resulting change by redrawing 

the set colors with the “Show Set Colors” button. 

Add SetAdd Set Remove SetRemove Set
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Set tag defaults that are used for auto-numbering shapes as they 

are dropped on the page.

First select the activity shapes using the shift key and in the 

CORRECT sequence and then click this button to create sequence 

arrows. This can be done a few shapes at a time. Note that the 

'Check' section in the toolbar does have a hide/show for sequence 

arrows. No sequence arrow loops are allowed.

Many of the calculations on the value stream map rely on the process sequence. This is defined 

on the map by using tag sequence arrows. 

TagsTags

SequenceSequence

Identifies each unique path through the value stream (via sequence 

arrows) and adds path ID’s to steps.

Assigns tags in the order provided by sequence arrows.

Auto PathAuto Path

Auto TagAuto Tag

Auto Pipe Select the activity from which to originate the pipe arrows, then 

hold down the shift key and select one or more activities to pipe to.

Auto Pipe – Many to One Select the activity to be at the head of the pipe arrow(s), then hold 

down the shift key and select or more activities to pipe from. 

Select the source activity and using the shift key, select all 

downstream activities to connect the source to with tag sequence 

arrows. This button is located in the dropdown of the Sequence 

button.

Using the shift key select the source activities from which to 

originate tag sequence arrows, to a single downstream activity 

(the final shape you select while still holding down the shift key). 

This button is located in the dropdown of the Sequence button.

Seq One to Many

Seq Many to One 
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SequenceSequence

To attach tag sequence arrows to tags, select a series of tags (or activities) in the correct 

sequence and then click the Sequence button in the toolbar.

The Tag Seq Arrow is used with Managed Equations and allows you to perform upstream and 

downstream calculations. This example shows how Accumulative Time can be calculated along 

the value stream with the use of Tag Seq Arrows.

1. Select the shapes in the correct order using the SHIFT key. 

2. Click the Sequence button in the toolbar to automatically create sequence arrows to the shapes. 

If these shapes do not already have tags, using the Sequence button after having selected them in 

order will automatically attach tags to each shape.  

Process A Process B Process C

Managed Equation

Accumulated Time =

ST(CT;Min;0;APPLY)

  + ST(Transport Time;Min;0;APPLY)

    + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

Managed Equation

Accumulated Time =

ST(CT;Min;0;APPLY)

  + ST(Transport Time;Min;0;APPLY)

    + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

Process A

CT Min15CT Min15

Accumulative Time Min15Accumulative Time Min15

Transport 
Time

Min10
Transport 

Time
Min10

Process B

CT Min20CT Min20

Accumulative Time Min45Accumulative Time Min45

A0340

A0340

A0330

A0320

A0350 A0360 A0370
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1. To use this function, select the center from which to originate the pipe arrows then hold down 

the SHIFT key and select one or more centers to pipe to. Resource A was selected and then 

while holding the SHIFT key, Activity B and C were selected. 

2. Click the “Auto Pipe” button to automatically create pipe arrows from one activity to many 

activities. 

3. Fill in the pipe arrow data of Resource Process Time which shows that Resource A is used for 

2 minutes per item for Activity B and 5 minutes per item for Activity C. 

Auto Pipe – Many to One

Alternately, you can use the Auto Pipe – Many to One button, which is in the dropdown menu of 

the Auto Pipe button, to create pipe arrows from multiple Resources into an Activity. 
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Pipe arrows are special arrows which allow data to flow between eVSM centers. Example usage: 

alllocate resource hours to an activity center, or collect costs from select activities.

The Auto Pipe functions allows you to automatically create pipe arrows from one center to 

another, one to many, and many to one.

Auto Pipe – Many to One

Auto Pipe



Copyright © 2019 The eVSM Group, All Rights Reserved 

After your shapes have been sequenced, there is an option to automatically generate the path IDs 

for all the possible paths on the map based on the sequence arrows. After shapes have been 

sequenced using the “Sequence” button in the toolbar, click “Auto Path” in the toolbar. This will 

automatically give paths to the shapes in the order that they have been sequenced. If you make 

changes to the sequence, just click Auto Path again to update the path IDs.

Warning: AutoPath regenerates path numbers for all shapes connected by sequence arrows and 

without consideration of the current path number on these shapes.

Auto PathAuto Path
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The Path List is used to identify a path or paths that a center belongs to. The shape is glued 

above the top right corner of the shape.

An activity can belong to no paths, one or more, or all paths. The benefit of assigning path 

numbers to activities is that the associated activity variables (like NVA time) can be summed up 

across the map in a path specific sense. 

After you have run the “Auto Path” button, each Path List could look like the following:

P

This center is only on path 2

The center is on all paths  

The center is on 3 different paths

To find out what Paths a center is on, right-click on the Path List          which will pull up a menu 

to display all the path numbers for that center or the whole map. You can also hide or show all 

paths and perform various functions as shown. Each path will be separated by comma, unless 

there are paths in a range which are denoted by x:x.

The path numbers for this inventory 

have been made visible. This center 

is on five different paths, which are 

1, 3, 5, 6, and 7.

A0030 6 P

Process

Inventory Item2Inventory Item2

A0750 7
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You can set preferences for activity tag numbering using the “Tags” form. 

To add or change an Operation Tag, first select the shapes you wish to attach a tag shape to. 

Click on the “Tags” button in the toolbar. After you  choose a tag prefix letter, next value, and 

increment value, click the “Add Tags” button.

A quick way to tag activities in order of the sequence arrows is to use the eVSM Auto Tag 

button.

The Auto Tag function works by re-tagging the whole map, so it disregards what you want as the 

“Next Value” in the Tag and Paths form.  It orders the shapes by tag sequence arrows and then z -

order (for un-sequenced rows). Then, it goes through the sequence, and it increments each tag by 

the user-assigned interval (in the Tag and Paths form), with numbers starting at 0010 for each 

letter prefix.

Tag numbers can also be named manually by double-clicking to edit the text. However, the name 

must be unique and must be one letter followed by four numbers.

Charts are generally plotted in alphanumeric tag sequence, and the AutoTag button does a great 

job to help charts plot in upstream to downstream sequence.

Auto TagAuto Tag

TagsTags
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Must do this before using the Solve button. Performs numerous 

checks on the model and reports back any problems.

A visibility toggle switch for tag sequence arrows. Generally 

recommended that you work with these visible so you can fix 

sequence arrows as you modify the map.

Removes various highlighter shapes used for glue display or 

problems displayed by the software.

This section contains checking functions to validate the model ahead of analysis. 

CheckCheck

Show Seq.Show Seq.

ClearClear

Show Pipes Just a visibility toggle switch for pipe arrows. Generally 

recommended that you work with these while visible so you can 

fix pipe arrows as you modify the map.

Please select shapes before clicking the “Same Paths” button. This will 

highlight the common paths that pass through ALL of the selected shapes.

Please select shapes before clicking the “Same Paths” button. This will 

highlight ALL of the paths that pass through all of the selected shapes.

  View Paths View and highlight all the paths on the map. 

Same Paths 

All Paths
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Show Seq.Show Seq.

ClearClear

The Check function checks the map and highlights (with a red circle) some common problems. It 

also automatically fixes somethings such as unglued operation tags, unglued datashapes, and 

duplicate datashapes.

Show Pipes

CheckCheck

Examples of problems the Check fuction will report:

• Missed mandatory data values

• Orphaned datasapes

• Unresolved units (missing unts convertors)

When the Check function finds a problem that requires attention, it provides useful information 

to fix it. Be sure to read this information so you can quickly resolve the issue.

The Clear button clears and highlighting generated by the Check function, path highlighting, Set 

colors, etc.
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If you have various paths on the map, and want to see the common paths that go through multiple 

centers, then use the Same Paths button in the toolbar. 

You must first select which centers on the map you ’d like to view the paths for. Hold down the 

SHIFT key if you want to select more than one center. In this example below, Process B and 

Process C are selected.

After the Same Paths button was clicked, Process B and Process C are highlighted, reminding 

you which centers were selected. Only the paths that go through both centers are highlighted, 

which are 1 and 2, shown in blue and red. 

To start a view with different centers, click the Clear button in the toolbar to clear all highlights. 

Alternatively, if you want to add centers to the original two you selected, just hold down the 

SHIFT key and select the new centers to add. Then click the Same Paths button again.

ClearClear

Same Paths Same Paths 

Same Paths Same Paths 

Show Paths on Center

Show Paths on All

Hide Paths on Center
Hide Paths on All
--------------------------------------------------
All Paths
--------------------------------------------------
Select Paths

Set Path From View

If you have a view of the paths that you would like to set into a 

Path Filter for a summary or chart, use the right -mouse option on 

the Path Filter and select “Set Path from View”. This was done for 

the example view above for paths 3 and 4.

all

Process A

Process B

Process C

Process D

Process E

A0010

A0020

A0030

A0040

A0050

#5

#3#3

#2

#4

#3

#4

#2

#3

eVSM 
Data

QuickMfg
11.06.002

8.0

Process A

Process B

Process C

Process D

Process E

A0010

A0020

A0030

A0040

A0050

#5

#3#3

#2

#4

#3

#4

#2

#3

#51

1

1

1

2

2

2

2

#5

  View Paths



Copyright © 2019 The eVSM Group, All Rights Reserved 

If you have various paths on the map, and want to see all of the paths that go through multiple 

centers, then use the All Paths button in the toolbar. In the example below, Process C and Process 

D were selected using the SHIFT key, and then the All Paths button was pressed. All of the paths 

are highlighted from Process C (3), and Process D (2). All PathsAll Paths

The right-mouse option on the Path Filter of “Set Path from View” will work for this function as 

well. 

If you have multiple paths highlighted, like the red, green, or blue boxes, you can view their path 

by highlighting the sequence arrows in the matching color. If you right -click on any of the 

highlighted path boxes, there is an option to “Highlight Path Arrows”. This has been done for 

path 3.

Process A

Customer A

Process B

Process C

Process D

Customer B

A0060

A0070

A0080

A0090
A0100

A0110

#3

#2

#2
2

3

3

2

2

2
2

3

3

3

Process A

Customer A

Process B

Process C

Process D

Customer B

A0120

A0130

A0140

A0150
A0160

A0170

#3

#2

#2
2

3

3

2

2

2
2

3

3

3
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The Path Marker, found in the eVSM Sequence stencil, allows you to name paths by specific 

centers on the map. Glue the Path Marker to any glue point on a center and make sure a glue 

connection appears. Then double-click the marker to enter the marker name. Once you have 

attached Path Markers to the desired centers on the map, click the “AutoPath” button in the 

toolbar to update the path names. After adding Path Markers, the path names can be seen either 

in the Path Filter Manager or by hovering over path numbers on ladder charts (like lead time 

charts).

In the example Lead Time chart below, there are three paths, denoted by the bold numbers. If you 

right-click any of the path numbers, there are options to:

Highlight Path: Puts blue highlights on the centers for that particular path

Animate Path: Animates that particular path with a moving token

Show Path Alias: Brings up a form that shows the path name based on the Path Markers

Process

A0010 1

xx

Lead Time Summary
Day

0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5

A0020
A

A0030
B

A0050
E

1
4.00

A0020
A

A0040
D

A0050
E

2
5.00

A0020
A

A0060
C

A0050
E

3
4.50

Non Value Added

Legend

eVSM 
Data

QuickMfg
11.06.002

8.0
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The Path Filter List, found in the eVSM Sequence stencil, is used to filter summary or chart 

shapes by path(s). The default will be “all”, if no changes are made. 

By double-clicking on the Path Filter List, the Path Filter Manager will appear, allowing you to 

choose which paths to work with. Use the “Add” or “Remove” buttons to move the desired paths 

to the “Selected Paths” box.

If you have attached any 

Path Markers on the map, the 

path name will appear next 

to the path number.

This Search field allows you to find paths on the 

map based on the Path name (using Path Markers), 

center text names (typically green), and tags (like 

A0010), and will move them to the top of the list.

Use the “Highlight” button to show 

the paths in the “Selected Paths” 

box visually on the map. 

Z0055 allall

Transport Summary

Total Transport 
Distance KmAuto

Total Transport 
Distance KmAuto
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Writes data out to excel, performs any calculations specified via 

managed equations and displays results back on the map. Also updates 

gadgets and charts on the map.

This section links the map to an underlying Excel spreadsheet to perform lean calculations with 

the results displayed back on the map. 

SolveSolve

Variational Solve Calculates values using variational data.

Tag Operation VA NVA Data Data Data Data

v
a

lu
e

 a
d

d
e

d

n
o

n
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lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n

c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

Visio

The eVSM Solve button in the toolbar provides bi-directional transfer of information between the 

map and a spreadsheet. When the button is clicked for the first time in a map, eVSM 

automatically creates a new Excel file and puts it in the same folder the Visio file is saved in. 

The function only operates on the current map page. All blue “Auto fields” will calculate to the 

appropriate values on the map.

SolveSolve

eVSM 
Data

QuickMfg
11.06.002

8.0

Z0010 #0 Z0050 #0

Time Summary Time Summary

Total Value 
Added

MinAuto
Total Value 

Added
MinAuto

Value Added 
Percent

%Auto
Value Added 

Percent
%Auto

Takt Time
Sec

Item
AutoTakt Time

Sec
Item

Auto

Lead Time DayAutoLead Time DayAuto

Total Value 
Added

Min1288
Total Value 

Added
Min1288

Value Added 
Percent

%24.34
Value Added 

Percent
%24.34

Takt Time Min4.20Takt Time Min4.20

Lead Time Day12.60Lead Time Day12.60
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eVSM now supports simple means of specifying variation in data for selected input values and 

creates variational output for designated calculated values. The example below pulled from a 

Quick Manufacturing example map. Note that this functionality does not with the Quick 

Transactional Pro stencil. 

1. Drag out a Normal Distribution icon from the eVSM Data and glue to the Cycle Time 

variable. Make sure a red glue connection appears to make sure it is glued properly.

2. The mean and standard deviation 

for the activity’s cycle time was 

entered.

3. We want to see what effect this will have on the Lead 

Time. The Output Variation icon from the main stencil 

has been glued to the Lead Time of the Summary Center. 

4. The Variational Solve button is selected and the user 

selects ‘75’ solve iterations. Each solve uses a random 

number generator to “pick” a value from each variational 

input. It also creates a sample output for each designated 

out variable. This is a simple type of Monte Carlo 

analysis.

Var Solve

5. Right-click on the Output Variation shape and select “Plot 

Output Distribution”.

6. The Lead Time has been plotted with the various confidence 

levels.

#0Z0010

Z0080 #0

Assemble

Time Summary

Cycle Time Min10Cycle Time Min10

Total Value 
Added

Min15.00
Total Value 

Added
Min15.00

Value Added 
Percent

%0.71
Value Added 

Percent
%0.71

Takt Time
Sec

Item
2520.00Takt Time

Sec
Item

2520.00

Lead Time Day2.52Lead Time Day2.52

Cycle Time Min20Cycle Time Min20

Qty Per Cycle Item1.00Qty Per Cycle Item1.00

Capacity
Item
Day

84.00Capacity
Item
Day

84.00

sdm sdm
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1. Connect a Variation Percentile shape from the eVSM Data stencil to the 

target variable (lead time in the example below), and set it to 95.

2. Create a managed equation (refer to the managed equations section) 

that equates lead time to the sum of the cycle time.

3. Press the Solve button in the toolbar and note that the lead time solves 

to 63.16. Without the percentile specification the answer would have 

been 50.

The Variation Percentile shape, when attached to a variable that is calculated via an equation, 

provides a way to access percentile values for any terms in the equation that have an associated 

distribution. In the example below, lets say we want to calculate a lead time that will not be 

exceeded 95% of the time.

SolveSolve

A0040

Process Process

Summary

Lead Time Min63.16Lead Time Min63.16 5Cycle Time Min20Cycle Time Min20
820 820

Cycle Time Min30Cycle Time Min30

A0020 A0030
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Multi-machine Page

This is used to link the data values across datashapes which may be on the same page or on 

other pages within the same file. In this example, the main map has an Assembly station that is 

actually a multi-machine. The data from the Multi-Station Wizard will be linked to the main 

map for the center.

Data Source

allA0020

Qty Per 
Cycle_M

Item1

Stations_M Stn2

Activity 
Time_M

Hr
Day

10

Activity

Cycle Time_M Min4

eVSM  Data

WizM fgM ul ti

Station

10.12.0021.

0

allA0030

Qty Per 
Cycle_M

Item1

Stations_M Stn1

Activity 
Time_M

Hr
Day

12

Activity

Cycle Time_M Min2

allA0040

Qty Per 
Cycle_M

Item1

Stations_M Stn1

Activity 
Time_M

Hr
Day

14

Activity

Cycle Time_M Min6

Z0010 all

Qty Per Cycle Item1.00

Stations Stn4.00

Activity Time
Hr

Day
11.50

Multiple Station Equiv.

Cycle Time Min3.45

123

Main Map
A0010

Customer

Customer 
Demand

Item
Day

7000

Share % %100

Effective 
Demand

Item
Week

Auto

Atlas

A0030

Activity Lead 
Time

Day0

A0040

Blanks

Inventory Item7500

DayAuto

Sharpen

A0050

1

SecAuto

Qty Per Cycle Item5

Cycle Time Min1

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0070

Moulded Blanks

Inventory Item3000

DayAuto

Assemble

A0080

1

SecAuto

Qty Per Cycle Item10

Cycle Time Sec2

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0090

Scissors

Inventory Item5000

DayAuto

Stations Stn1

Data Target

123
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The Assemble activity center on the main map is represented by the equivalent multi -machine. 

The goal is to populate the input fields for the Assembly activity from calculated values on the 

multi-machine map. The Multi Station Wizard has been purposely designed so that it calculates 

the values that the activity on the main map needs AND has the SAME variable names (Cycle 

Time, Stations, etc.). In the special case where source and target variable names are identical, 

source and target identifiers can be glued to the center shape as shown below.

1. In the same file as your main map page, create a new page. Click the Open button and use 

the Mfg Multi Station Wizard to create the example map shown on the previous page. After 

you have created it, name the page to MS. Drag out the “Data Source” marker from the 

eVSM Data stencil and glue to the Multi Station Summary Center. Note that source 

variables can be located on the same page as the target variable or on another page in the 

same file.  Enter an ID, like 123 which will be used for the target marker as well.

Multiple Station Equiv.

Stations Stn4.00

MS Capacity 
Per Day

Item683.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item800.00

MS Cycle Time Per 
Item Min0.86

OEE %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

Z0010 P

123
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Note that the default setting for the target variable is set to sum all of the source variables. You 

can right-click on the target and change sum to average, max, or min.

2. Go back to the main map page and drag out a “Data Target” marker and glue to the side of 

the Activity Center. Enter 123 for the ID. In order for the calculation to be correct, the first 

five variables from the multi-station summary center MUST be on the Activity Center. If 

they are not, you will have to manually drag them out from the Quick stencil and glue to 

the Activity Center.

3. If the source and target variables are on separate pages, the page where your target 

variable is must be linked to the source page. Make sure each page in your Visio File has a 

memorable name in order to differentiate pages when setting the scope. 

#0A0040

Assemble

Qty Per Cycle Item1

OEE Percent %x.xx

Cycle Time Minx.xx

Stations Stn1

Activity Time
Hr

Day
x.xx

OEE Input 
Percent

%x.xx

123

1

4.  In this example, go to the main map page where your target is and click the NUM button in 

the toolbar to open the dialog box to set the page scope. 

5. Click “Source/Target Pages” at the 

bottom of the box and select the page 

on which your source marker is 

located. 

NUMNUM
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In the general case when you are trying to link values of variables with different names, you 

should glue the source/target markers onto the side of the variable as opposed to the whole 

center.

If the units are not the same, there must be compatible 

unit converters, like Min to Hr, located on the source 

page for the solve function to convert the value. If the 

units are not compatible and you try to solve, an eVSM 

Warning message will appear telling you to create a unit 

converter. See the example below which shows different 

variable names and units, but was able to link the values 

because of the correct unit converter.

Target Page

Source Page

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0050

Z001

0
#0

Activity

Multiple Station Equiv.

Qty Per Cycle Item1Qty Per Cycle Item1

Cycle Time Secx.xxCycle Time Secx.xx

CT Hr0.13CT Hr0.13

Cycle Time Min7.93Cycle Time Min7.93

Qty Per Cycle Item1.00Qty Per Cycle Item1.00

OEE %56.90OEE %56.90

MS CT Capacity 
Per Day

Item348.00
MS CT Capacity 

Per Day
Item348.00

MS Capacity 
Per Day

Item198.00
MS Capacity 

Per Day
Item198.00

MS Cycle 
Time Per Item

Min1.98
MS Cycle 

Time Per Item
Min1.98

27

27

6060

Hr

Min

Hr

Min
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eVSM has an XL Report builder that will export the tag, operation, 

type, and custom variables one directionally to Excel. 

2. Right-click on the XL Report shape and select “Edit Report Data”.

3. Enter a Report Name which will 

be the page name in the Excel 

file. 

4. Click “Add” to create a category 

header. 

5. Click “Add” to select the 

variables to the export to the XL 

Report. 

6. Select the desired variable from the dropdown 

menu.

7. If you don’t want the default unit, uncheck this 

box and change the units manually. 

1. After your map has been solved, drag out the XL Report icon 

from the eVSM Kaizen stencil. 

XL

Report

XL

Report
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Tag Operation Type Time

Cy
cl

e 
Ti

m
e

Cu
st

om
er

 D
em

an
d

Min Item/Wk

A0010 Prepare 5

A0010_A0020

A0020 Paint 10

A0020_A0030

A0030 Package 8

A0030_A0040

A0040 Customer 100

8. After you have finished adding the desired variables, right-click on the XL Report shape and 

select “Run Report”.
Edit Report Data

Run Report

XL

Report

XL

Report
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Allows management of gadget families providing geometric views of key 

numbers of the map with color coding, scale factors and hide/show.

Updates all the geometric gadgets based on the current map values.

The view capability simplifies maps with better utilization of map space. Also allows the 

visualization of the numbers using gadgets and charts. 

GadgetsGadgets

UpdateUpdate

ViewsViews
Opens a window for modifying variable visibility settings for the map.

To prevent maps from looking crowded, there are a large number of variables in eVSM that are 

hidden. The views capability allows you to manage which variables you would like to be hidden/

visible on the map. 

ViewsViews

1. Click the Views button in the toolbar.

2. This will open the form below which allows you to manage the visibility of variables on the 

map. The dark gray boxes indicate the hidden variables on the map, and white boxes represent 

that the visible variables on the map.

3. Check the boxes of some variables that are currently grayed out.

4. Click OK and the changes will apply to all centers on the map.

Lets you hide Quick Centers on your map by having their corresponding 

rows in Excel hidden. This lets you keep as much data as you want in 

Excel, and use Excel's built-in filtering tools to control visibility in eVSM.

You can make a view permanent using the 'Copy Filter View' button, and 

make calculations on your map using that view.

Filter
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Reverts all Views settings 

to the Default, as they 

were when the map was 

first started.

Hides all the (blue) 

calculated datashapes

Switch off to hide all 

datashapes on map
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Any data on the map can be linked to visual gadgets that change in size and color with change in 

the data. Some gadget types are shown below:

Each gadget has exactly one size parameter that can be tied to a data value on the map. Here ’s 

the typical means used to apply and manipulate gadgets:

1. Drag out the gadget from the eVSM Visuals stencil and position it near the data value with 

which it will be associated (in this case the “Cycle Time”). In this example the Bar Height 

Gadget is being used.

Process

Cycle Time Min2Cycle Time Min2

2. This system shape will be automatically dropped on the page the first time a gadget is used. 

If you copy a map to a new page make sure you also copy this shape because it is used to 

hold gadget data for the map.

3. Select the gadget, drag and glue the gadget’s yellow flying connector to the side of the 

NVU data shape (avoid gluing to the top or bottom of the data shape).

Process

Cycle Time Min2Cycle Time Min2

Bar Height 
Gadget

GadgetsGadgets
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4. Right-click on the gadget and use the “Activate Gadget” option to create a new gadget 

collection. The collection name will be “Bar_Cycle Time”. The name is created from the 

gadget type and the data variable name.

A gadget can only belong to one collection. Each collection can only have a single type 

(e.g. “Bar”) of gadget.

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

5. You can change gadget scale factors and color code them by modifying the properties of 

the associated Gadget Collection. You can easily create additional gadgets tied to other 

instances of the same data on the map. Just click on the gadget and use the right mouse 

button to select “Create Gadgets By Example” to create the gadget for Process B below.

Process A

Cycle Time Min2Cycle Time Min2

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

Process B

Cycle Time Min6Cycle Time Min6

6. Note that the new gadget is automatically positioned, scaled and put into the same 

“Bar_Cycle Time” collection. If you do not wish to have new gadgets created for the whole 

map than select the original gadget, then sub-select an area of the map before using the 

“Create Gadgets By Example” menu.

Process A

Cycle Time Min2Cycle Time Min2

Process B

Cycle Time Min6Cycle Time Min6
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7. To modify a gadgets scale factor or to color code it, you need to change the properties of its 

associated collection.  Right mouse click on the gadget and select “Manage Gadget 

Collections,” or click the Gadgets button in the toolbar. GadgetsGadgets

To hide or show gadgets in a 

collection, first select the collection 

from a list, then click this button.

Note: the collection list has a column 

indicating visibility status.

You can modify the scale factor for a collection 

that controls gadget size in relation to data value. 

Use the Apply button to see the new  gadget sizes 

on the map before exiting the form.

You can color code the gadget fill and 

font colors based on the value of the 

data to which the gadget is glued. You 

can also simply “inherit” the color from 

the data shape or assign a color to a 

gadget manually.
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▪ Gadgets have a single size parameter that will scale to the data value in which a gadget is 

glued via the flying yellow connector.

▪ Gadgets are typically glued to NVU, VA or NVA shapes. When gadgets in a collection are 

glued to data shapes with different units, Units Converters are needed on the map to 

compute the correct scale factors.

▪ Gadgets have to belong to a collection. They can be put in a collection using the Activate 

Gadget command or by transferring them into a collection via the Manage Gadgets form.

▪ Gadget scale factors and color coding can be controlled via the Manage Gadgets form.

▪ An easy way to create a gadget “set” after creating a first gadget is to use the Create 

Gadgets By Example in the right mouse button menu.

▪ The Visible switch on the Manage Gadgets form is very useful in showing different 

metrics on the map in a presentation environment.

▪ See the “Examples” section on the eVSM help site (www.evsm.com/help) for usage 

examples of the different gadget types.

▪ A starter set of gadgets is provided with eVSM. Additional gadgets can be requested by 

contacting support@evsm.com.
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There are three gadgets that can be used to visualize hidden data in shapes on the map.

Image Text Gadget:

Text and Value Unit Gadget:

Text and Value Gadget:

For example, if you have kaizen bursts with various properties assigned, you can visually see 

them with the combination of image, text, value and units. You can customize the font, color, and  

size of the gadget to apply map wide. The instructions below will explain how to visualize the 

Impact number with the Text and Value Gadget.

1. The kaizen burst must have the properties you want to visualize already 

assigned. From the eVSM Visuals stencil, drag out the Text and Value 

Gadget and place it near the starburst.

2. Select the gadget, drag the yellow flying connector, and 

glue it to a glue connection along the edges of the starburst. 

Make sure a glue connection appears.

3. To change the “abc” to “Impact”, click the abc text box, and click the “F2” button on your 

keyboard to edit the text. This is where you can also customize the font size, color, and 

positioning as the standard.

Name Value Unit=Name Value Unit=

xx Unitabc = xx Unitabc =

xxabc = xxabc =

xxabc = xxabc =

xxImpact = xxImpact =

Kaizen 
Data

Problem

001

Problem

001
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4. Right-click the gadget and select “Activate Gadget”. 

5. Select “Impact” from the list. 

Once you click OK, the Impact number from the kaizen will be inputted into the gadget.

6. To apply this gadget to the rest of the kaizens on the map, right -click the gadget and select 

“Create Gadgets by Example”. You can manually move the gadgets, otherwise they will be 

created in the same location in relation to the starburst as the original one.

7. If you change any of the values shown by gadgets, you can click the “Update” button in the 

eVSM toolbar to update all gadget values. UpdateUpdate

4Impact = 4Impact =

Problem

001
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The Conditional Color Gadget allows the ability to color code values 

based on value ranges. 

1. Drag out the Conditional Color Gadget from the eVSM Charts and Gadgets stencil.

2. Click on the gadget, and use the yellow flying glue 

connector to glue to any side of a variable. Make sure a red 

glue connections appear, confirming that it is glued.

3. Right-click the gadget and click “Activate Gadget” if 

there is only one on the map, or select “Create Gadgets by 

Example” if you would like to add a gadget for that 

variable map wide. 

4. Click the Gadgets button in the toolbar. GadgetsGadgets

5. Select the Gadget collection.

6. Click the “Color Code…” button.

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0020

Process

Qty Per Cycle Item1Qty Per Cycle Item1

OEE Percent %95.00OEE Percent %95.00

Sec15.00 Sec15.00

1.001.00

Cycle Time Sec15Cycle Time Sec15

Scrap Percent %5Scrap Percent %5



Copyright © 2019 The eVSM Group, All Rights Reserved 

7. Select “Based on Value Ranges(s).

8. Fill in the desired ranges 

with the fill color.

9. The Gadget will change to the color chosen. If values 

change, so will the gadget color after Solve is run. 

#0A0030

Process

Qty Per Cycle Item1Qty Per Cycle Item1

OEE Percent %95.00OEE Percent %95.00

Sec15.00 Sec15.00

1.001.00

Cycle Time Sec15Cycle Time Sec15

Scrap Percent %5Scrap Percent %5
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Enable Flying Connector

Name Help

________________________

Select all with Name

Select all with Name on Path

Edit Name.. (Cycle Time)

Edit Unit.. (Min)

Plot Name Values

Plot Distribution Values

There is now the option to plot the name values for all variables on the map. 

1. Drag out three activity centers and fill in the values.

2. Right-click on Cycle Time and select “Plot Name Values” in the menu.

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0040 #0A0030 #0A0050

Drill Wash Inspect

Qty Per Cycle Item1Qty Per Cycle Item1

Cycle Time Min2Cycle Time Min2

Qty Per Cycle Item1Qty Per Cycle Item1

Cycle Time Min4Cycle Time Min4

Qty Per Cycle Item1Qty Per Cycle Item1

Cycle Time Min6Cycle Time Min6

MinAuto MinAuto MinAuto MinAuto MinAuto MinAuto

Visualize - Cycle Time

M
in

0

1

2

3

4

5

6

A0030 A0040 A0050

Cycle Time

Legend

Visualize - Cycle Time

M
in

0

1

2

3

4

5

6

A0030 A0040 A0050

Cycle Time

Legend
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XY Charts (Combination & Pareto Charts) - Any numeric data available for analysis in eVSM 

can be plotted on a chart such as this:

Cross Dock

Assemble

30Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Test

10Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Ship

500Defects ppm

Drill

20Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Sharpen

75Cycle Time Secs

15
Changeover 

Time
Hrs

1Operators Staff

50Batch Size Pairs

Mold Handles

53Cycle Time Secs

2
Changeover 

Time
Hrs

2Operators Staff

50Batch Size Pairs

38500

Scissors

Pairs 27000

Scissors

Pairs 31000

Scissors

Pairs 7000

Scissors

Pairs 5000

Scissors

Pairs75000

Scissors

Pairs

ATLAS 
Warehouse

1

Frequency

Per 
Week

1

Frequency

Per 
Week

MRP

Production
Control

Forecast 30 Days
Weekly Order

Daily

Daily

130.00 Secs

4.17 Days

75.00 Secs

2.14 Days

20.00 Secs

1.50 Days

30.00 Secs

1.72 Days

10.00 Secs

0.39 Days 0.28 Days

Weekly Schedule

Summary

18000Daily Demand Pairs

10.19
Production 
Lead Time

Days

265.00
Processing 

Time
Secs

Daily Ship Schedule

5

Wks

Days

2

Days

Shifts

7.5

Shifts

Hrs

60

Hrs

Mins

60

Mins

Secs

Plant Summary

2.00
No of Shifts 

per Day
Shifts

5.00
No of Work 

Days per Wk
Days

15.00
Production Hrs 

per Day
Hrs

500.00Defects ppm

62.50Raw Materials Hrs

4.17
Finished 
Goods

Hrs

86.25
Work in 
Progress

Hrs

67Takt Time Secs

A10 A20 A30 A40 A50 A60

A70

B10

B20

ACME Scissors
Current State Chart

Maker

Before creating a chart, you must ensure that the data to be plotted is:

- Contained in eVSM data shapes

- The data shapes are glued to the parent rowmaker shapes

- Rowmaker shapes are tagged with Operation Tags

Hint: Use the Glue Check and Excel Check buttons in the eVSM toolbar to verify

1. Drag out the XY Chart icon from the stencil, and place it anywhere on the map. 

2. Set up chart parameters and click “Plot Chart” command in the right mouse button menu.

XY Chart

Edit Chart Data

Plot Chart

Create Spreadsheet

Right mouse click on the shape and 

select the “Edit Chart Data” command.

Cycle Time - Takt Time Chart
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Set data filters

Enter chart title Select Y-axis 
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Optional chart 

description

Variables will be 

plotted in sequence 

shown here. Use Up 

Down buttons to 

change sequence

XY
Chart
XY

Chart
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Options for Chart Variables:

3. Click the Plot Chart command in the right mouse button menu.

Notes:

▪ Each eVSM Chart is a group of simple shapes. Avoid ungrouping these as this may displace 

some of the shapes.

▪ Chart will update automatically when the Calculator is run. To update the chart manually, 

use the “Update command in” the chart’s right mouse button menu.

Edit Chart Data

Plot Chart

Create Spreadsheet

Milestone Charts

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

1. Get data ready in this format:

Set a default value for non-

existent plot points

Select Variables to plot

Select Display Type

Enter Tag number for 

single tag data plot

Set color of fill or lines

Sales Milestones
Manufacturing 

Milestones

Order Approved Days90Order Approved Days90

Order Shipped to 
Customer Days10Order Shipped to 
Customer Days10

Order Accepted Days0Order Accepted Days0

Manufacturing Begins Days80Manufacturing Begins Days80

Inspection Complete Days30Inspection Complete Days30

Manufacturing Complete Days15Manufacturing Complete Days15

A0030 A0040
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Milestone 

Chart

2. Drag out the Milestone Chart icon and click the “Edit” 

command in its right mouse button menu.

3. Complete the form:

4. Plot chart.

5. Use the “Update..” command in the chart’s right mouse button menu to update the chart 

when the data changes.

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspect ion 

Complete

Manufacturing 

Complete

Update Milestone Tag Chart

Milestone 

Chart

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Milestone Chart

The Cumulative Bar Chart allows you to visualize the phases of a value stream on a timeline.

Order Fulfillment Timeline

Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

Order Fulfillment Timeline

Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

1. Get data ready in this format:

2. Drag out the Cumulative Bar Chart icon 

and click the “Edit” command in its right 

mouse button menu.

Cumulative 

Bar Chart
Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

Cumulative Bar 
Chart

Order Fulfillment 
Timeline

1Process Order Days

8Order Approval Days

3Scheduling Days

15Wait for Mfg Days

10Manufacturing Days

1
Wait for 
Delivery

Days

2Delivery Days

B070
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4. Plot the chart:

5. The chart will update automatically when the Calculator is run. To update the chart 

manually, use the Update command in the chart’s right mouse button menu.

Order Fulfillment Timeline
Days

0 5 10 15 20 25 30 35 40

Process 
Order

Order 
Approval

Scheduling Wait for Mfg ManufacturingWait for 
Delivery

Delivery

Update Cumulative Tag Chart

Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

The Ladder Chart shape allows you to create timeline and operator balance charts such as the 

following:

Operator Balance Chart
Min

0 2 4 6 8 10 12 14 16

A010De-burr 

Casting

A010De-burr 

Casting

Operator1

A020Assembl

e Lining

A020Assembl

e Lining

A030Install 

switch

A030Install 

switch

Operator2

A040Solder 

Wiring

A040Solder 

Wiring

Operator3

Operator Balance Chart
Min

0 2 4 6 8 10 12 14 16

A010De-burr 

Casting

Operator1

A020Assembl

e Lining

A030Install 

switch

Operator2

A040Solder 

Wiring

Operator3

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010De-

burr 

Casting

A010De-

burr 

Casting

A020Asse

mble 

Lining

A020Asse

mble 

Lining

A030Insta

ll switch

A030Insta

ll switch

A040Sold

er Wiring

A040Sold

er Wiring

Non Value Added Value Added

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010De-

burr 

Casting

A020Asse

mble 

Lining

A030Insta

ll switch

A040Sold

er Wiring

Non Value Added Value Added

3. Complete the form:

Cumulative 

Bar Chart
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Update Chart

We will plot a Timeline Ladder for the VA/NVA times from this VSM.

Solder Wiring

13Operator3 Min

A040

9 Min

4 Min

De-burr Casting Assemble Lining Install switch

3Operator1 Min 12Operator1 Min 7Operator2 Min

A010 A020 A030

2 Min

1 Min

9 Min

3 Min

4 Min

3 Min

Ladder 
Chart

Ladder 

Chart

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010
De-burr 
Casting

A020
Assemble 

Lining

A030
Install 
switch

A040
Solder 
Wiring

Non Value Added Value Added

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet

1. Drag out the Ladder Chart icon and click the “Edit” command in its right mouse button 

menu.

3. Plot chart:

4. The chart will update automatically when the Calculator is run. To update the chart, 

manually, use the “Update Chart” command in the chart’s right mouse button menu.

2. Complete the form:

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet

Ladder 

Chart
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The Filter button in the eVSM toolbar lets you hide Quick Centers on your map by having their 

corresponding rows in Excel hidden. This lets you keep as much data as you want in Excel, and 

use Excel's built-in filtering tools to control visibility in eVSM. Filter

The corresponding page name in Excel must be the page name you are using in Visio + “_ID”. So 

if the page name in Visio was “VSM”, then the Excel page name needs to be “VSM_ID”. 

The data must be started on row 2, with headers on row 1, and the first column named “ID” to 

identify the centers. Below is an example of the Excel sheet with the corresponding ID on the 

Activity Center. 

1. In order to specify the Quick Centers from Visio to Excel, an ID shape must be glued to it. 

From the “eVSM Data” stencil, drag out the “Long NVU” shape and glue it to the center. 

eVSM 
Data

QuickMfg
11.06.002

8.0

1A0010

#0A0020

Process

Process

Activity Lead 
Time

Day7
Activity Lead 

Time
Day7

Activity Lead 
Time

Day0
Activity Lead 

Time
Day0

ID TxtAID TxtA

Name Unitx.xxName Unitx.xx
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2. Then click the NUM button in the toolbar to create an ID variable. NUMNUM

3. Click the “New Unit” 

button.

4. Enter the unit name of 

“Txt” and then click OK.

5. Click the “New Name” 

button.
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6. Enter the Name “ID”.

7. Select the new unit “Txt” that was created. Then 

click OK.

8. Double-click on the Name field, and select the newly created “ID” NVU. Then click OK.

9. In the x.xx field, type the unique ID for that center. 

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0010

#0A0020

Process

Process

Activity Lead 
Time

Day0
Activity Lead 

Time
Day0

Activity Lead 
Time

Day0
Activity Lead 

Time
Day0

Name Unitx.xxName Unitx.xx

ID TxtAID TxtA
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10. Once you have attached IDs to the desired Quick Centers, and hidden the rows in Excel for 

the view you want, then go back to the Visio file and click the “Filter” button. Filter

11. Once that view of the centers is configured on the page, a message will appear asking to close 

the filter view, or make a copy of that filter view to another page so you can make calculations 

on your map using that view.
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Allows addition of improvement ideas on the map supported by Impact matrix, Risk matrix, and 

Kaizen Report. 

Kaizen Properties

Kaizen Export

Kaizen Import

Renumber Kaizens

Select the kaizen/project property set for the map.

Creates an Excel spreadsheet of Kaizens with their property data.

Reads an Excel spreadsheet of Kaizens with property data back to 

eVSM.

Renumber the Kaizen shapes in the order they are selected. 

Numbering starts at 001, and any un-selected Kaizen shapes get 

numbered after the selected Kaizen shapes.

You can now standardize your kaizen custom properties by selecting the set of data for the 

Kaizens on the map. The Kaizen Properties button in the toolbar will bring up a form allowing 

you to select which properties to standardize on for the map. Kaizen Properties

Kaizen 
Data
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The Kaizen Export toolbar button scans the map for all Kaizen shapes (Starbursts) and exports 

custom properties associated with the shapes to Excel spreadsheets (Pagename_Kaizen). This 

Excel spreadsheet will show the connectivity of Kaizen starbursts with activities and other 

Kaizen starbursts. If you want to edit the custom properties data via Excel, you may do so and 

import the data back into eVSM using the Kaizen Import button.

Kaizen 
Starburst

1. Open a blank Visio drawing page with the Quick Manufacturing stencil. 

2. Drag out an Activity Center.

Kaizen 
Starburst

Kaizen Export

Kaizen Import

Problems can be documented using Kaizen starbursts, which 

can now be connected to activities as well as other Kaizens.

4. Click the Kaizen Properties button in the toolbar to bring up the form to see which properties 

are available as well as a description of each.

Check or uncheck the boxes to add/

remove properties to the standard 

custom properties list when editing 

each kaizen on the map. 

Kaizen Properties

Double-click the word “Visible” to 

toggle all of the properties on or off.

3. Drag out two Kaizen Starbursts from the eVSM Kaizen stencil. Edit the descriptions to 

“Reduce Changeover Times” and “More Frequent Deliveries”.

Reduce 
Changeover Times

001

More Frequent 
Deliveries

002

Problem

123
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5. Click the Kaizen Export button in the toolbar to create a Kaizen Report in Excel. Kaizen Export

The Kaizen impact matrix was introduced in a late version of v5 and uses the “Impact” and “Ease 

of Implementation” custom properties of kaizen starbursts to plot an impact matrix. The goal of 

the matrix is to help select projects for implementation to improve the value stream.

The mini-Kaizens in the matrix copy the custom properties of the originals (map Kaizens). They 

are numbered based on the ID’s of the Kaizens on the map (ID’s are circles glued to the top left 

of the kaizen shapes). A right-mouse click on any of the mini-Kaizens allows for selection and 

highlighting of the parent map kaizen. 

6

Highlight Kaizen

1. Change the Impact and Ease of Implementation properties of each starburst by right -clicking 

the starburst and selecting “Edit Kaizen”. A form will appear allowing you to edit the various 

properties. Similarly, you could also edit the values via Excel spreadsheet and use the Kaizen 

Import button to bring the values back into eVSM.

Impact (1-5):  What impact this project will have on 

the value stream.

1 = Low, 5 = High

Ease of Implementation (1-5):  How easy/difficult 

will it be to implement this measurable 

improvement to the Value Stream?

1 = Difficult, 5 = Easy

Kaizen Import

Kaizen 
Data
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Kaizen Impact Matrix

Plot Kaizen Impact Matrix

2. Change the fill color of each starburst if you wish.

3. Drag out the Kaizen Impact Matrix icon from the eVSM Kaizen stencil and right -click to plot 

the matrix, which is shown on the next page.

4. If map Kaizens are modified, then the Impact matrix can be updated by selecting it with a right 

mouse click and the command “Update Chart”.

5. Using the Renumber Kaizen button in the toolbar, Kaizens can be renumbered in order starting 

at 001. Select the starbursts in the sequence you want using the Shift key, and then click the 

Renumber Kaizens button. Any un-selected kaizen shapes will get numbered after the selected 

kaizen shapes. Renumber Kaizens

Kaizen 
Impact 
Matrix

Reduce 
Changeover 

Times

001

More Frequent 
Deliveries

002
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6. Drag out the Kaizen Key Creator from the eVSM Kaizen stencil to differentiate each starburst 

by description which is shown under the matrix.

Kaizen Key Creator

Kaizen 
Data

5

4

3

2

1

1 2 3 4 5

Ease Of Implementation
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Kaizen Impact Matrix

001

002

Kaizen Bursts

(001) Reduce Cycle Time

(002) Incorrect Assembly
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1. Drag out a Kaizen starburst shape from the eVSM Kaizen 

stencil. Type “Reduce Cycle Time” into the starburst. Enter the 

values for the likelihood and severity by clicking “Edit 

Kaizen” via right-mouse menu.

2. Drag out another Kaizen Starburst. Type “Incorrect 

Assembly” into the starburst. Enter the likelihood and severity 

values via the Edit Kaizen form.

3. Drag out the Kaizen Risk Matrix from the eVSM Kaizen 

stencil. Kaizen Risk Matrix

The Kaizen Risk Matrix plots the kaizen starbursts based on the risk likelihood and risk severity 

values set up in the “Kaizen Properties” form brought up from the right-mouse menu. It also 

multiplies the values together to create an RPN number between 1 to 25.

Risk Likelihood (1-5):  What is the 

likelihood of risk to the Value Stream if this 

project is not done/issue is not addressed?   

1 = Low, 5 = High

Risk Severity (1-5):  What is the 

likelihood/impact in the Value Stream if 

this identified risk did actually occur?   

1 = Low, 5 = High

Kaizen 
Risk 

Matrix

Reduce Cycle Time

001

Incorrect Assembly

002
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4. Right-click the chart shape to plot.
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Once you have clicked the Kaizen Export button in the toolbar and your Excel spreadsheet 

appears, there should be a page named “KaizenFormat”. The changes made on this page will 

effect the actual report which is page named “PageName_Kaizen”. 

In the “KaizenFormat” page in the spreadsheet:

• D1: Change the font color of this cell to set these properties for all Data headers 

• D2: Change the font color, boldness, or italics of this cell to set the default for the Property 

names

• D3: Change for the fill color or row height of this cell to set these properties for all units

• B5: Change the fill color of this cell to set this color for all kaizen numbers

• Each Property header can have a unique fill color, set by this page

• To hide an entire row or column, right-click the row number or column letter and choose 

“Hide”. To unhide that row or column, select the row before and after the hidden one by 

holding down the SHIFT key, or the column before and after the hidden one, and then right -

click and select “Unhide”.

The Kaizen Report in Excel can be formatted with custom properties of color, font, visibility, and 

row height. In order to be able to edit this formats, you need a specific Excel file. To get this file 

in the correct location for usage:

1. Create a new folder called "eVSM Standards" at the same level as the “eVSM” folder on the 

C: drive>Program Files (x86)

2. Copy the templates file called “eVSMExcelTemplate.xlt” from the C:Drive>Programs Files 

(x86)>eVSM>Setup>Resources folder to the newly created “eVSM Standards” folder

3. Customize the templates file as needed by following the instructions below

Template page for 

editing properties 

for the Kaizen 

Report

Page name of 

Calculations 

page from 

“Solve”

A ReadMe page that 

lists any editing 

instructions for 

importing values   

Kaizen Report 

(PageName_Kaizen)

Excel Worksheets
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Map Copy

      Settings

      

Migrate

      Move Data

Provide utilities for upgrading older eVSM maps to v11.

Change settings for this document that affect some features and 

performance of eVSM. 

Click the ‘Settings’ button to access the File Settings dialog box with 

the following options: 

Change settings for this document that affect some features and 

performance of eVSM.

Allows you to move your map data to a new page using a new stencil. 

Create a duplicate of this page on another page in this file. 

Map Extract Extract the selected page to a separate file. 

Internal Solver: A new (faster) solver is available in beta mode and can be used if excel input/

output on solve is not required. 

Automatic Chart Update on Solve:  Chart update takes significant time during solve. You can 

turn auto update off and choose to manually update charts. 

      Settings
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Automatic Units Parsing: When enabled, this allows input of values like 1m 30s wherever 

time measures are required. This saves time in capturing data. 

Excel Color Synch: When enabled, this synchronizes Excel cells and Visio shape colors on 

solve. This makes solve take longer. 

On Drop Variables: When enabled, data shapes (NVUs) dropped on the page are connected to 

the nearest center. 

Pre Solve Data Source Pages: When enabled, data sources on other pages than the main solve 

map will be solved also. This ensures the data sources on calculated values are always up to 

date.

Delete Assist: When enabled, eVSM will prevent you from accidentally deleting shapes, and 

will also delete an entire center when you delete the center parent shape. 

Trace Over Mode: When enabled, dropping centers from the stencil over shapes on a 

background page will make the dropped center ‘inherit’ the text and fill color of the shape 

behind. 

Separate Starbursts and Clouds:  When enabled, eVSM will output Kaizen Starbursts and 

Clouds to separate Excel worksheets when you use the Kaizen Export. 

Hide Transparency Level: Impacts the brightness of shapes that are hidden by ‘fading’ them 

in the Layout, Customer Journey, and other eVSM applications. 

Cache Mixed Model Data: Faster editing of Mixed Model input data; requires you to run Auto 

Path after modifying arrows and/or centers on the page. 

NUM Mixed Model Solve Stages: Set number of Solve stages needed for Mixed Model solve.

 

Automatic Shape Positioning and Alignment:  When shapes are dropped on the page, this 

enables easy insertion, automatic positioning to grid locations, and alignment to adjacent shapes. 
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The migrate button will initiate migration of eVSM v8, v9, and v10 maps to eVSM v11 format. 

The conversion is not 100% so some manual work will be required after migration. For example, 

charts are not migrated, so they need to be re-plotted in the new file. The Views settings may 

also not be exactly the same.

Migration attempts to migrate all pages in the file and will create a new file for the current 

version. It will also add some markup in the old file to highlight items which have not been 

converted.

Recommended steps to migrate a file:

1. Backup the old file.

2. Open the old file to migrate making sure there are no other Visio files already open.

3. Hit the Migrate button. Migration will take some time for large files.

4. On completion, save both the old and the new files.

5. Scan through the old file to find items which are highlighted. These items have to be re -

created manually in the new file.

6. Once you have completed any manual work in the new file, run the Check function on each 

page and fix any problems reported.

7. Run Solve and resolve any differences you see in calculation results.

Once a map is migrated to the current version, it cannot be opened in older releases of eVSM.

If you need to open a new version map in an old version of eVSM for viewing/printing purposes, 

here is a workaround:

1. In Visio, click "File > Options > Trust Center > Macro Settings > Disable all macros 

without notification". This will stop VBA from running the next time you start Visio.

2. Exit Visio.

3. Make a copy of the new version eVSM file, and open. 

Note: Remember to reverse Step 1 when you wish to re-activate VBA.

      

Migrate
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Move Data allows you to convert a map from on e application type to another. E.g.: 

Convert a Quick Mfg map to Quick Processing.

The conversion can not be 100%, but it will generally capture the flow and some of the 

data. 

The function allows you to select the target stencil and will create a new page where it 

will draw the flow with shapes from the target stencil, and then copy some of the data it 

considers equivalent. 

Steps:

1. Navigate to the original map page

2. Click ‘Move Data’ (located in Migrate drop down box)

      Move Data

3. Select the target stencil and click OK

4. The function will create a new page with the original page name, plus _ target stencil name.

5. Check and manually complete the new page. 
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Using the Map Copy button, eVSM can copy your map to another page in the file. This function 

saves time as opposed to using Visio’s regular copy and paste functions. It also duplicates the 

whole model, including shapes which are hidden through Views or Layers.

1. Click the Map Copy button in the toolbar.

2. A box will appear asking you to enter a page name for the new page in the file.

3. Type in a name for the new page. 

4. Your entire map will be copied to this new page in the same file. 

Map Copy

Tip: Visio 2016 and later versions have a “Duplicate” command in the page tabs which does the same 

thing.
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eVSM Visio files can have multiple pages, each with a different map or other diagrams. 

Sometimes such files can get too big to Email or do general work with. The Map Extract 

function allows you to extract a single page into a new file. 

The current page in the old file is the one that gets extracted. The result will be a new one -page 

file which will be saved in the same folder as the original with the same name plus the page 

name. 

Map Extract
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Accesses the eVSM on-line help site.

Builds a page full of all the choices available in an eVSM Stack shape 

master. Select a blue icon (from any of the eVSM stencils on the right) 

or green icon (from any Quick stencil) before running this tool.

Provides an on-line access to help resources and training options. 

HelpHelp

Icon Search Search for shapes in eVSM stencils.

Stack Help

eLearning Opens the “My Gradebook” page on the eVSM website to check 

course status of eLearning material.  

eVSM 
Data

QuickMfg
11.06.002

8.0

Gives you information about your eVSM license and installation 

status.

Licensing

Map Clean Cleans your data by moving to a new Visio file. 
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1A0020

Process

Qty Per Cycle Item1Qty Per Cycle Item1

Cycle Time Minx.xxCycle Time Minx.xx

For variable name help, right-click any variable and select 

“Name Help” in the menu for a description of the variable.

MinAuto MinAuto

The Stack Help button creates a new page in the file with all of the available shapes for a 

selected stack. An icon can be identified as a stack shape if it is blue or green in an eVSM 

stencil.

1. Select the blue stack Transport Shape from the eVSM 

Material stencil.

2. Click the Stack Help button in the eVSM toolbar.

3. A new page will be created with the page name “Transport 

Shapes_Stacks” in the file with all of the shapes in the 

Transport stack.

Stack Help
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As you work in a Visio fie, over time, you may see some performance degradation as the Visio 

cache grows. The Map Clean function allows you to clean this up. It essential creates a new 

empty file, and copies all your maps to it.

We recommend you run this if you suspect any corruption in the file, or if you see performance 

degradation. It is a good idea to run the Map Clean function every couple of hours when working 

with large files. 

This function is also available through the Windows Start menu (useful if your eVSM toolbar is 

missing) at “Start > Programs > eVSM Software > eVSM Repair”. This will open the dialog box    

shown below. 

Just click the “Repair a Corrupt File” button and follow the prompts. 

Reset the eVSM 

environment to recover 

a missing eVSM toolbar

This is the Map Clean 

function

Map Clean
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The Icon Search button in the eVSM toolbar allows you to search for icons in any of the eVSM 

stencils. The search looks at the name and the brief help behind each icon and presents results in 

a separate search stencil.

1. Click the Icon Search button in the Learn module of the eVSM toolbar. 

2. Look for “OEE” in the Quick Mfg stencil.

3. The resulting shapes associated with OEE will be brought up in a new search stencil.

Icon Search

Icon Search
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Quick eVSM consists of ready-built stencils for specific application areas. Using these Quick 

Stencils will increase productivity and reduce learning time. Application areas supported include:

• Supply Network Mapping

• Plant Mapping (Discrete Parts and Assemblies) 

• Plant Mapping (Food and Chemicals)

• Mix Model Mapping

• Quick Response Manufacturing

• Services and Healthcare Mapping

• Customer Journey Mapping

• Project Management and Problem Solving

• Facility Planning

OpenOpen

To access a Quick stencil, click the Open button in the toolbar.
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Red icons are used to initiate the map for the chosen application area. Red icons 

must be dropped first on the new map. The red icons block the map from being 

used with any other Quick stencil.

Green icons, called “Centers”, are used to represent the flow.

Yellow icons, called “add-ons” are additions to “centers” for optional 

calculations. These add-ons must be properly glued to the data shapes under the 

Center. The yellow icons that follow a Center in the Quick stencil can only be 

used with that Center. Note the first word in the add-on names matches the parent 

Center.

Magenta icons represent charts.

White icons used for miscellaneous macro shapes.

The red Data icon acts as the vault for all of the system data for the map such as names, units, 

equations. Each stencil has its own data icon that must be dragged out first. 

Manufacturing
Data

The Quick Stencils will be located on the left side of the Visio drawing page. Quick stencils 

contain macro shapes which are collections of individual shapes, sometimes with names, units 

and calculation equations built-in.

Quick eVSM maps must be initiated with the red icons found at the top of each Quick stencil. 

Once the red icons from a Quick stencil have been dropped on a page, the page is locked for use 

with that Quick stencil. You cannot add content from other Quick stencils. You can however add 

icons from the main stencil (right side) at any time. Some icons (e.g. Arrows) are available only 

in the main stencil.
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Time Center

The Time Center shows the actual time (after deducting break times) the value stream operates 

for. Activity level local time can be specified for activities which work to a different schedule. 

Other units are available.

The Centers typically come out with tags and data shapes properly glued to the parent shape 

(green icon)

Customer
Center

The Customer Center represents the customer is where the customer demand is specified. Where 

multiple customers exist, a separate Center can be used to represent each customer.

eVSM 
Data

QuickMfg
11.06.002

8.0

#0A0030

A0020 all

55

Week

day

Week

day

xxxx

Week

Hr

Week

Hr

5252

Year

Week

Year

Week

U
n

it
s

Process

Customer

Qty Per Cycle Item1Qty Per Cycle Item1

Capacity
Item
Day

AutoCapacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto
Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %AutoOEE Percent %Auto

SecAuto SecAuto

11

Cycle Time Secx.xxCycle Time Secx.xx

Customer Demand
Item
Day

xxCustomer Demand
Item
Day

xx

This is an Operation 

Tag used to sort 

data for charts.

Path List. Used to show specific 

paths. Also used to filter data for 

calculations and charts.

The green shape acts as 

the parent. If moved, 

everything glued to it will 

move with it. 

Units can be changed to 

other compatible units by 

double-clicking.

xx represents mandatory 

data items. Without this 

data, the calculations 

cannot be completed.

Blue “Auto” fields will be 

calculated automatically 

be eVSM.
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The Quick Manufacturing stencil is designed to represent discrete parts flowing through plant 

level manufacturing value streams. Both, the material and information flow may be represented. 

The Quick Manufacturing stencil includes built -in calculations for:

▪ Lead Time, Value added time, Takt time

▪ Scrap, OEE, and other common activity losses

▪ Energy and space calculations

▪ Multi-stations, part-time, over-time, shared resources

▪ Cost of activities, inventory, transport, scrap

▪ Transport distances

▪ Multi-paths

Used to draw office, administrative, and general services value stream maps. May be used for 

any value streams concerned primarily with information flow.  

Supported calculations include:

▪ Lead Time, Value added time, Takt time, Cumulative Rolling Time

▪ %Complete & Accurate (%C&A)

▪ Multi-stations, part-time, over-time, shared resources

▪ Multi-paths and looping

Used to capture value streams that require following a patient through admin and non -clinical 

processes.

Supported calculations include:

▪ Lead Time, Value added time, Takt time, Cumulative Rolling Time

▪ %Complete & Accurate (%C&A)

▪ Multi-stations, part-time, over-time, shared resources

▪ Multi-paths and looping
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• Supply Network: Model inbound and outbound supply for a product. Includes analyses for 

lead time, risk, and Total cost of ownership. Maps can be overlaid onto geographic views for 

additional insight.

• Warehousing: Stencil for Warehouse process mapping

• Manufacturing: Stencil for plant level value stream mapping for discrete parts and assemblies 

that allows calculation of takt time, lead time, and capacities.

• Mfg. Multi Station: Application to calculate the properties of an equivalent machine that has 

the same capacity as multiple machines with differing properties. Designed to be used with 

Quick Processing.

• EPEI: Application to calculate min possible and actual EPEI (Every Part Every Interval) 

intervals for multiple products going through a single station with differing demands and lot 

sizes.

• Quick Materials: This supports quantification and reduction of the materials waste in the 

value stream and for detail steps within one process of the value stream. Includes provision 

for six sigma type X-Y association showing control variables that contribute to waste 

outcomes.

• Kanban: Calculates Kanban sizing and quantities for a simple Kanban loop and using safety factors 

against demand variation and supply issues.

• Changeover: Allows analysis of converting a line or machine from running one product to 

another with calculation of walk times, work times, and separation of internal and external 

work components. Also computes cost of product capacity lost during changeover. Supports 

changeover work content from multiple staff. Generates C/O work chart with timings.

• Processing: Stencil for plant level value stream mapping of chemicals and food processes that 

allows calculations of takt time, lead time, and capacities.

• Proc. Multi Station: Application to calculate the properties of an equivalent machine that has 

the same capacity as multiple machines with differing properties. Designed to be used with 

Quick Processing.
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• Mixed Model Quick Time: A simple stencil to represent the flow and perform a time and 

resource analysis for a mix of products, information, or patients.

• Mixed Model Manufacturing: Mapping and modeling of value streams (discrete parts and 

assemblies) creating multiple products with different operational parameters, shared 

resources, and differences in routing. Provides visual feedback of routes and utilization by 

product. Results in better waste identification and the ability to do useful 'what -if' studies.

• Mixed Model Food and Chemicals: Mapping and modeling of value streams (food and 

chemicals) creating multiple products with different operational parameters, shared 

resources, and differences in routing. Provides visual feedback of routes and utilization by 

product. Results in better waste identification and the ability to do useful 'what -if' studies.

• Mixed Model Supply Network: Model inbound and outbound supply value streams creating 

products with different operational parameters, shared resources, and differences in routing. 

Includes analyses for lead time, risk, and Total cost of ownership. Maps can be overlaid onto 

geographic views for additional insight.

• MCT: Stencil for drawing the MCT (Manufacturing Critical -path Time) flow, timeline, chart, 

and flow summary. 

• POLCA: POLCA (Paired-cell Overlapping Loops of Cards with Authorization) is a variant of 

Kanban, suitable for companies which produce many different and/or customized products.

• Quick Materials: This supports quantification and reduction of the materials waste in the 

value stream and for detail steps within one process of the value stream. Includes provision 

for six sigma type X-Y association showing control variables that contribute to waste 

outcomes.

• Changeover: Allows analysis of converting a line or machine from running one product to 

another with calculation of walk times, work times, and separation of internal and external 

work components. Also computes cost of product capacity lost during changeover. Supports 

changeover work content from multiple staff. Generates C/O work chart with timings.
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• A visual representation of the experience your customers have with your products and 

services. Allows ideation and prioritization to move the customer experience to one that build 

loyalty, a long term relationship, and long term revenue

• Project: This application allows visual project planning and scheduling with start/end 

constraints, and associated resource usage costs. Automatically generates a Gantt chart and 

allows highlighting of the critical path. 

• Decision Tree: This application allows the creation of decision trees that lead to different 

outcomes as characterized by a flow percentage and a value.

• A3 Report: Create A3 Reports in Visio with a starter template and a dedicated stencil of 

standard shapes from eVSM.

• Event Circle: Event or Communication Circles allow you to visualize all the transactions in a 

given pathway or process.

• Quick Time: Quick Time stencil simply measures the time (VA & NVA) associated with a 

value stream. It has no other variables. 

• Transactional Pro: Merges key concepts from business process modeling and lean into a 

unified VSM solution to help improve transactional value streams for office, services, and 

healthcare.

• Layout: The Layout Wizard supports visual planning of area layout with qualitative and 

quantitative consideration of material flows, transport mechanisms, service requirements and 

auxiliary conditions. It is a very visual approach and loosely based on the layout planning 

methodologies developed by Muther, Apple, and others.

• Spaghetti Diagram: This wizard allows you to draw paths on a floor plan and then export a 

Path Report with distances to Excel.

• Plant Milkrun: Allows design of material delivery routes and replenishment periods within a 

plant via overlay sketching on floor plan with calculation of travel times, load times, and 

unload times. Allows usage of specific transport types and one or more standardized 

containers per milk run.



Copyright © 2019 The eVSM Group, All Rights Reserved 

Examples for many of these stencils can be found on the eVSM website Examples page at https://

evsm.com/examples
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Identify operations in the value stream and start at the 

customer end. 

Use the right mouse button to swap to another process 

shape.

Operation 
Shapes

Start the map at the customer end.

Drag out the ‘Operation Shapes’ icon and right-click 

the shape to change it to a customer shape. Operation Shapes

Drag and drop, then glue arrows to the operations or 

their data shapes for easy future modification of the 

map.

Use the right mouse button to swap to another arrow 

type (like this Push arrow) Stepped 
Arrows

Expedited

Information

Kanban

Material

Push

Service

Value stream data which you may later want to use in calculations must be represented in eVSM 

data shapes. eVSM has the following data shapes:

Long NVU Value 
Added

Non Value 
Added

Short NVU

Process

Process

Process

Process
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To add variable names/units to the right mouse button (RMB) menu, follow these steps:

1. Click the following button in the eVSM toolbar to open the Name & Unit Manager (NUM) 

dialog.

2. To add a new unit, click the “New Unit…” button.

NUMNUM

Data shapes consist of two or three fields. To move or delete a data shape, you MUST click on 

the Value field. To edit any of the fields, simply double-click on the desired part and you will be 

able to make any changes.

Data shapes must be glued directly, or via other 

shapes, to the activity they represent.

3. All variable names must have a default 

unit. When adding new variable names, 

first make sure that the unit you 

wish to make the default for the new 

variable, exists in the units list. Then, click 

the “New Name…” button and follow the 

prompts.

Process
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Additional data can be added to a process. Drag & glue a new NVU to 

the bottom of an existing NVU.

Data shapes that do not touch the operation or its data shapes directly 

should be associated with the operation by dragging the flying yellow 

connector and gluing it to the operation.

Note: Flying connectors should NOT be used where shapes are 

touching.

Long NVU

VA and NVA shapes are available to construct a timeline on 

the map.

Glue these shapes to operational shapes with a flying 

connector.

When there are several VA/NVA metrics to be tracked, the 

Long NVU shape should be used instead of the specific VA, 

NVA shapes.

Drag out the NVU shape and glue it to the bottom of the inventory rectangle 

to document inventory type and quantity. Use additional triangles and NVU 

blocks for each inventory type.

After an inventory shape has been dragged out, it can be changed to a variety of inventory 

shapes. Use the right mouse button to swap to another inventory shape (Queue, In -tray etc..).

Inventory 
Shapes

Short NVU

Delay

FIFO Inventory

Hopper

In Tray

Inventory

Kanban Inventory

Package Forming Inventory

Query

Queue

Silo

Supermarket Inventory

Wait

Process

Process

Process

Minx.xx Minx.xx

Dayx.xx Dayx.xx
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Supermarket and Buffer shapes work in a similar way to the Inventory 

Shape. Any data must be glued to the base of the shape.Supermarket

Short NVU

Drag out Transport Shapes and place them on the map or glue them 

to arrows. NVU shapes holding related variables can be attached to 

the base of the icons.

Use the right mouse button to swap to another transport type 

(Train, Helicopter etc..).

Transport 
Shapes

Finished Goods

Transmit Shapes work in a similar way to Transport 

Shapes and are generally applied to information 

flow.

Transmit 
Shapes

Transmit 
Shapes

By Foot

Computer

Fax

Pager / Radio

Phone

Post

Print

Web Form

_______________

Framing

Right-click on a transmit or transport shape on the map to show 

alternate methods.

At the bottom of the list is a “Framing” option that allows the 

outer box around the shape to be turned on or off. When turned off 

the shape looks as below:

Process

Control 

Activity
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The eVSM Swimlane function allows drawing of VSMs and flowcharts in swimlane layout, 

horizontally or vertically. The eVSM Swimlane shape is an implementation of the eVSM Table 

function. 

To calculate totals or plot charts for each lane, see the Path List function.

Note: The swim lane function in native Visio is NOT supported with eVSM. The eVSM 

Calculator will not work if the Visio swim lane shape is on your drawing page.

Horizontal 
Swimlane

Vertical Swimlane

Lane A     Lane B

L
a
n
e
 A

L
a
n
e
 B

3. Pick the “Select Table” command in the right mouse menu to highlight 

the yellow diamonds. Move these yellow diamonds to the required width 

and height positions. Then click the “Adjust Table” command in the right 

mouse menu.

4. Double-click the “Header” to edit the text.

5. To move the table to a new position on the map, click the “Select 

Table” command in the right mouse menu. Then drag the table to the 

desired location.

1. Drag out the Horizontal Swimlane from the eVSM 

Information stencil. 

2. Right mouse click on any of the lanes to bring up the 

modification menu allowing for row/column addition and 

modification.

Select Table

View Row and Column Size Adjusters

Adjust Table

Clone Row Below

Clone Row Above

Delete Row

Use as Standard Row Height

Clone Column on Right

Clone Column on Left

Delete Column

Use as Standard Column Width
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Only shapes with a grey corner in the stencil can be tagged. These are called Excel rowmaker 

shapes since each of these creates its own row in the spreadsheet. 

Row shape examples:

Operation 
Shapes

Transport 
Shapes

Transmit 
Shapes

The eVSM Calculator has some requirements, and if these are violated, the calculator will stop 

and display an error message. The problem area will be highlighted on the map with a red circle 

for you to correct. We recommend using the Check button before clicking Solve.

Map.xlsMap.vsd

When the eVSM Calculator is run for the first time, the Excel file is created automatically and 

saved in the same folder as the Visio file. The Excel file is given the same name as the Visio file. 

Unit conversion variables in Excel are also scoped by the page name.

SolveSolve

Duplicate or Unglued Tags: Each Operation Tag on the map must have a unique value and must 
be glued to a valid Row Shape.

Overlapping Data Shapes: Some Data Shapes are hidden behind others because of overlap, and 
is not allowed.

Duplicate Data Shapes: Each Data Shape within a Row Shape collection must have a unique 
variable name. 

Grouped Shapes: eVSM Shapes should not be grouped. The Calculator will abort if grouped 
shapes are found.
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Equations may be entered in the spreadsheet cells in which Data Shapes are represented. 

Steps:

Data columns sorted 

by variable name

Select 

Cell

Type “=” followed 

by an equation

Click the Enter 

button

1

2

3

The next time the Calculator is run, the result of the equation will be displayed in the appropriate 

data shape on the map. The calculated value will be color coded red to show it is controlled by 

Excel.

Note: After the “=” sign, instead of an equation (e.g. =C3*D12), static values (e.g. =216) can 

also be entered. This allows entry of measured metrics directly in the spreadsheet.
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A

aliases 2929

align timeline 2626

arrows 108108

auto path 4343

auto pipe 4242

auto tag 4545

B

blue icons 66

blue stacks 111111

browse data 2424

C

calculate 5252

calculator problems 114114

chart variables 7575,7373

charts 7373

check 4747

clear 4747

conditional color gadget 7070

create xl 3333

cumulative bar chart 7575

current set 2222

D

data source 5555

data target 5555

draw sets 3838

E

equation manager 2222

evsm stencils 55

extras 9090

F

filter 7878

flying connectors 110110

fractional units 2323

G

gadget color-coding 6666

gadget hide/show 6666

gadget key points 6767

gadget scale factor 6666

gadgets 6464

grid 55

H

help 9696

hide/show 6262

https://evsm.com/evsm-technical-support#toc-133

https://evsm.com/install 33

I

icon search 9999

import xl 3434,3333

improve 8282

isolate sets 3939

K

kaizen export 8383

kaizen impact matrix 8484

kaizen import 8383

kaizen properties 8282

kaizen risk matrix 8787

kaizens 8383

L

ladder chart 7676

lean enterprise institute 44

learn 9696

list variables 2525,2424

M

main stencil 33

managed equations 2222

map clean 9898

map copy 9494

map extract 9595

migrate maps 9292
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milestone chart 7575

mix manager 3636

move data 9393

N

name and unit manager 2222,1818

non value added 110110

num 109109,1818

nva 110110

O

operational data 108108

P

path list 4444

plot name value 7272

printing 88

product matrix 3737

Q

quick stencils 100100,33

R

renumber kaizens 8585

reverse scale 3535

S

same paths 4848

scale locs 3535

select timeline 2626

sequence 4040

sequence arrow 4141

shapes 44

show pipes 4747

show seq 4747

show sets 3838

sketch 1515,1010

snap 55

solve 5252

source and target 5555

stack help 9797

stencils 44

swimlane 112112

T

tag seq arrow 4141

tags 4545

text editing 55

text value gadget 6868

timeline 2626

transport shapes 111111

U

units converter 1919

V

v11 migration 9191

va 110110

validate 4646

value added 110110

var solve 5353

variation percentile 5454

variational data 5353

view paths 4949

views 6262

visualize 6262

W

wall map 1111

X

xl report 5959

xy chart 7373

Z

zooming 77
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